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Introduction

The Keysight Technologies, Inc. N9075A and W9075A 802.16 OFDMA 
measurement applications provide one-button measurement and 
modulation analysis capabilities to help your design, evaluation, and 
manufacturing of Mobile WiMAX™ devices.

This demonstration guide follows the list on page 2. Each 
demonstration includes a brief description of its function and the 
corresponding measurement steps on the signal generator and/or 
signal analyzer.
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802.16 OFDMA Test Measurements 

 – Channel power1

 – ACP (adjacent channel power)1

 – Spectrum emission mask1

 – Spurious emissions

 – Occupied bandwidth1

 – Power versus time

 – Modulation analysis (including 

spectral flatness)

 – Power statistics CCDF

 – Monitor spectrum1

 – IQ waveform

1. These measurements require a timing  

trigger to capture the burst power on 

period. To measure time-gated spectrum 

analysis for bursted signals, gated LO 

function is required. “Gate required for 

valid results” is shown in the status mes-

sage at the bottom of display when these 

measurements are running. Use time gating 

with gate setups under [Sweep/Control] 

key. Minimum equipment configuration 

requirements

 

Demonstration Preparation

All demonstrations use an X-Series 

signal analyzer and the N5182A MXG 

vector signal generator. Keystrokes 

surrounded by [ ] indicate front-panel 

keys; keystrokes surrounded by { }  

indicate softkeys located on the 

display. 

Helpful tip:

To measure the analog baseband I/Q OFDMA  

signal, connect the MXG signal outputs (either 

single-ended or differential) to the MXA signal 

analyzer with Option BBA. By switching the input 

from RF to I/Q, you can make the same modulation 

analysis in the OFDMA measurement application.

Helpful tip:

Update your instrument firmware and software to 

the latest version, at

www.keysight.com/find/xseries_software

www.keysight.com/find/signalstudio

http://www.keysight.com/find/xseries_software
http://www.keysight.com/find/signalstudio
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Minimum equipment 
coniguration  
requirements

To configure these instruments, 

connect the MXG’s 50 Ω RF output to 

the X-Series signal analyzer’s 50 Ω RF 

input with a 50 Ω RF cable. Turn on 

the power in both instruments. Now 

set up the MXG and Signal Studio 

for 802.16 WiMAXTM software to 

generate a OFDMA signal.

Instruments Model number Options (recommended or required) 

MXG vector  

signal generator

N5182A  

Firmware revision  

1.04 or later

Required:

 – 503 or 506 – Frequency range at  

3 GHz or 6 GHz

 – 651, 652 or 654 – Internal baseband  

generator

 – UNV – Enhanced dynamic range  

(required for better ACP performance)

Signal Studio for  

802.16 WiMAX  

software

N7615B  

Version 2.0.0.0  

or later

 – 503, 508, 507 (EXA and CXA), 513 or  

526 – 513 and 526 not available on CXA

X-Series signal 

analyzer 

N9000A, N9010A, 

N9020A, or 

N9030A  

firmware revision 

A.06.xx or later

Recommended:

 – EA3 – Electric attenuator, 3.6 GHz 

 – POx – Preamplifier

802.16 OFDMA  

X-Series signal 

analyzer  

measurement 

application

N9075A–N9010A, 

N9020A, N9030A, 

W9075A–N9000A 

only

Required:

 – 2FP: 802.16 OFDMA measurement  

application, fixed perpetual license OR

 – 2TP: 802.16 OFDMA measurement  

application, transportable license

Controller PC for  

Signal Studio for  

802.16 WiMAX 1

Required:

 – Install N7615B to generate and download 

the signal waveform into the MXG via GPIB 

or LAN (TCP/IP). Please refer to the online 

documentation for installation and setup

1. Or install Signal Studio software on the X-Series signal analyzer if you want to connect the MXG with a  

cross-over LAN cable.
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Demonstration Setup

Instructions Software operations

On the Signal Studio for 802.16 

WiMAX software:

Start the Signal Studio for  

802.16 WiMAX software

Start > Program > Keysight Signal Studio > 

802.16 WiMAX

Connect the Keysight MXG as  

hardware via GPIB or LAN (TCP/IP)

Follow the Signal Studio for 802.16 WiMAX 

instructions to connect to the Keysight MXG 

N5182A

Configure the signal of single 

antenna

Select Quick Setups and double click M x 1

Set the basic parameters of the  

signal at center frequency 2.5 GHz, 

amplitude –10 dBm, RF output  

turned On, and ALC On

Click Signal Generator at the left on the  

Explorer menu.  

Instrument model number = N5182A.  

Press [Preset] green button on the top.  

Frequency = 2.5 GHz, Amplitude = –10 dBm,  

RF Output = on, ALC = on

Confirm the waveform setup  

from upper level

Click Waveform Setup to see the fundamental 

waveform signal setups. 

Under Waveform Properties, you can set 

WiMAX common parameters as follows:

Built frames = 1

Frame duration (ms) = 5

Output mode = downlink only (TDD)

Downlink ratio (%) = 61.771

Guard period = ⅛

Symbol rolloff = 5.0%

Configure a test signal for  

demonstrations

Click Carrier 1 under Waveform Setup on the 

left of the Explorer menu.  

Carrier 1: State = on, Radio format = advanced 

802.16 OFDMA, 10 MHz BW, 1024 FFT size,  

0 Hz frequency offset, power at 0.00 dB.  

Use the default settings of reference spec 

Create a single carrier signal  

including downlink only

Click Downlink and check following parameters

Preamble index = 0

Group bitmask = 111111[Binary], 3F[Hex]

Number of symbols = 6

Symbol offset = 1

Max number of subch = 30

Configure Zone #1, PUSC Select Zone#1 PUSC to check the following 

parameters. 

Zone boost = on

Number of symbols = 6

Auto allocation = on

Auto FCH = on

Auto DL-MAP = normal

Auto UL-MAP = normal

Connect the PC,  
X-Series, and MXG 
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Demonstration Setup, continued

Instructions (continued) Software operations

On the Signal Studio for 802.16 

WiMAX software:

Add two more data bursts in  

Zone #1 PUSC

Press [+] once for regular data burst #2 and 3

Configure MAC messaging Auto DL-MAP = normal 

Auto UL-MAP = normal 

Modulation and coding = QPSK (CC) ½

Modulation and coding =  QPSK(CC) ½

Configure Burst #1 Select Burst#1 to check the following 

parameters.  

Modulation and coding = 16QAM (CTC) ½  

Data length [Bytes] = 300

Modify Burst #2 Change the modulation and coding 

Modulation and coding = QPSK (CTC) ½ 

Data length [Bytes] = 64

Modify Burst #3 Change the modulation and coding 

Modulation and coding = 64QAM (CTC) ¾ 

Data length [Bytes] = 540

Download the signal to MXG Press Generate and Download on the top tool 

bar. If you encounter any errors, please refer 

to the online help of Signal Studio for 802.16 

WiMAX software 

Save the setting file for future reuse. 

This saved .scp file will be used in 

modulation analysis later

File > Save As… > OFDMA_Demo1.scp  

(Name it as you like)

Export the waveform file for future 

reuse

File > Export Waveform Data > 

OFDMA_Demo1.wfm (Name it as you like) 

Instructions

On the Keysight X-Series signal 

analyzer:

Connect 10 MHz reference output  

into X-Series signal analyzer

Reference input at rear panel 

[Input/Output] Freq Ref In > External

Connect EVENT 1 output into MXA. 

This is an external trigger at the 

OFDMA frame boundary

External trigger 1 at rear panel
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Demonstrations

Demonstration 1: 

Channel power

Channel power measures and reports 

the power in the integrated bandwidth 

as well as computed power spectral 

density (the power in the signal is 

normalized to 1 Hz).

You have the ability to adjust the  

following channel power  

measurement parameters:

 – Integration bandwidth  

(defaults to 10 MHz)

 – Number of trace averages  

(default to 200)

 – Data points displays, 101 to 20001 

(default to 1001)

 – Configure RRC filter with flexible 

filter alpha value (default to Off)

 – Trigger source: free run, video, line, 

external-½, RF burst, and periodic 

timer (default to free run)

 – Time gating with gate source:  

line, external-½, RF burst, and peri-

odic timer (default to periodic timer 

with sync source = RF burst)

This measurement requires a timing 

trigger to capture the burst power on 

period. To measure time-gated spec-

trum analysis for burst signals, gated 

LO function is required. With your 

burst signals, please use any external 

trigger or gated LO with the X-Series 

signal analyzer configured by gated 

LO setups under [Sweep/Control] key.

If you need to measure the OFDMA 

burst signal and don’t have an exter-

nal trigger, please use a periodic timer 

as the gate source with an RF burst 

as the sync source.

Instructions Keystrokes

On the X-Series signal analyzer 

OFDMA mode:

Preset X-Series signal analyzer [Mode Preset] 

Move to 802.16 OFDMA mode [Mode] 802.16 OFDMA (WiMAX/WiBro)

Choose transmitter radio device for 

base station (downlink)

[Mode Setup] Radio Device BS MS

Set a center frequency at 2.5 GHz [FREQ] [2.5] GHz

Run a channel power measurement [Meas] Channel Power

Set the sweep time as Auto [Sweep/Control] Sweep Time Auto

Configure time gating with gate 

source of external trigger 1 at the rear 

panel. (Figure 1)

[Sweep/Control] 

Gate = On Gated [LO] 

Gate View = On

Gate View Sweep Time = 5 ms

Delay = 71 us

Length = 50 us

Gate Source = Periodic timer

Periodic timer

Periodic = 5 ms

Sync Source = RF burst

Figure 1. Channel power in 802.16 OFDMA mode
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Demonstration 2: 

Adjacent channel power (ACP)

This is a measurement for the power 

present in adjacent transmit channels. 

The span is set according to the six 

available offsets and their associate 

integration bandwidths defined by 

users or the selected radio standard.

You have the ability to adjust the 

following adjacent channel power 

measurement parameters:

 – Measure up to 12 carriers for  

multi-carrier ACP

 – Adjust integration bandwidth

 – Select up to six channel offsets

 – Choose channel offset frequency

 – Adjust and display both absolute 

and relative power

 – View bar graph over spectrum trace

 – Use built-in averaging detector 

(RMS) for speed and accuracy

 – RRC filter with flexible filter alpha 

value

 – Noise correction On/Off  

(default to Off)

This measurement requires a timing 

trigger to capture the burst power 

on period. To measure time-gated 

spectrum analysis for burst signals, 

gated LO function is required.

“Gate required for valid results” 

would be seen in the status message 

at the bottom of display when these 

measurements are running. Use 

time gating with gate setup under 

[Sweep/Control] key.

If you need to measure the OFDMA 

burst signal and don’t have an exter-

nal trigger, please use periodic timer 

as the gate source with RF burst as 

the sync source.

Figure 2. ACP

Instructions Keystrokes

On the X-Series signal analyzer  

OFDMA mode:

Measure ACP [Meas] ACP

Check the bar graph over the trace [View/Display] Bar Graph On Off

Turn on noise correction [Meas Setup] More > Noise correction On 

Off

Change sweep time [Sweep/Control] Sweep Time [10] ms

Check the time gating setup 

Adjust gate in Gate View if necessary

[Sweep/Control] Gated [LO] 

Gate View = Off

Restart measurement (Figure 2) [Restart]
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Figure 3. BC3 spectrum emission mask

Demonstration 3:

Spectrum emission mask 
(SEM)

The spectrum emission mask 

measurement includes the in-band 

and out-of-band spurious emissions. 

It may also be expressed as a ratio 

of power spectral densities between 

the carrier and the specified offset 

frequency band.

The application includes several  

pre-defined masks for easy recall, 

as well as the ability to save custom 

masks into state file.

Perform the following key steps to 

find available masks:

[Recall] > {Data (Import)} > {Mask} 

and {Open...}. And remember to save 

customized masks into state files for 

future reuse.

This measurement requires a timing 

trigger to capture the burst power 

on period. To measure time-gated 

spectrum analysis for burst signals, 

gated LO function is required.

“Gate required for valid results” 

would be seen in the status message 

at the bottom of the display when 

these measurements are running.  

Use time gating with gate setup under 

[Sweep/Control] key.

If you need to measure the OFDMA 

burst signal and don’t have an exter-

nal trigger, please use periodic timer 

as the gate source with RF burst as 

the sync source.

Instructions Keystrokes

On the X-Series signal analyzer 

OFDMA mode:

Activate a spectrum emission mask 

measurement

[Meas] Spectrum Emission Mask 

Choose the type of values to display. 

Observe the measurement values 

change in the lower window to 

reflect the selected value type 

(Figure 3)

[View/Display] Abs Pwr Freq or Rel Pwr Freq 

or Integrated Power 
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Demonstration 4:

Spurious emissions

The spurious emissions measurement  

identifies and determines the power 

level of spurious emissions in 

user defined frequency bands. The 

measurement allows the user to set 

pass/fail limits and a reported spur 

threshold value. The results are  

conveniently displayed in a result 

table that can show up to 200 values. 

Instructions Keystrokes

On the X-Series signal analyzer 

OFDMA mode:

Measure the spurious emissions [Meas] Spurious emissions

Confirm how to modify the range  

table (Figure 4)

[Meas Setup] 

Figure 4. Spurious emissions
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Figure 5. Occupied bandwidth

Demonstration 5:

Occupied bandwidth

The occupied bandwidth measurement  

places markers at the frequencies for 

which the specified percentage of 

the power is contained and reports 

this bandwidth. The measurement 

defaults to 99% of the occupied 

bandwidth power.

It also indicates the difference 

between analyzer center frequency 

and the center frequency of the  

channel. The difference is referred  

to as “transmit frequency error.”

You have the ability to adjust the  

following occupied bandwidth  

measurement parameters:

 – Changeable occupied bandwidth  

% power

 – Measure 99% occupied bandwidth 

and the user-definable x dB band-

width as well

This measurement requires a timing 

trigger to capture the burst power 

on period. To measure time-gated 

spectrum analysis for burst signals, 

gated LO function is required.

“Gate required for valid results” 

would be seen in the status message 

at the bottom of display when these 

measurements are running. Use 

time gating with gate setup under 

[Sweep/Control] key.

If you need to measure the OFDMA 

burst signal and don’t have an exter-

nal trigger, please use periodic timer 

as the gate source with RF burst as 

the sync source.

Instructions Keystrokes

On the X-Series signal analyzer OFDMA 

mode:

Measure the occupied bandwidth [Meas] Occupied Bandwidth

Check the time gating setup. Adjust 

time gate in gate view if necessary 

(Figure 5)

[Sweep/Control] Gated [LO]  

Gate View = On

In this measurement, the total power 

of the displayed span is measured. 

Then the power is measured inward 

from the right and left extremes until 

0.5% of the power accounted for in 

each of the upper and lower parts of 

the span. The calculated difference 

is the occupied bandwidth. In accor-

dance with the 802.16e-2005 10 MHz 

preset, the X-Series signal analyzers 

default to a 10 MHz PASS/FAIL limit 

values.
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Demonstration 6:

Power versus time

This measurement examines time 

domain burst shape if the incoming 

signal satisfies the test limit profile 

defined by users. After capturing IQ 

data in the time domain, this mea-

surement calculates the power vector 

(magnitude square vector) from the 

IQ vector. Burst detection parameters 

will help to search a burst power vec-

tor automatically. If you want to verify 

the signal against an external timing 

source, the burst auto detection func-

tion can be disabled. In addition, the 

burst detection algorithm searches a 

burst from the beginning of the cap-

tured data and picks up the first one 

which satisfies the burst detection 

parameters. For example, if there are 

two valid bursts in the captured data, 

the second burst will be disregarded. 

In WiMAX OFDMA, the captured TDD 

(time division duplex) signal could 

contain both downlink and uplink 

bursts. In this case, you need to use 

an external trigger with appropriate 

trigger delay so that the downlink or 

uplink burst comes to the beginning 

of the captured data selectively.

Although the 802.16e-2005 standard 

does not define any conformance test 

for power versus time mask, pass/fail 

limit mask test is commonly used to 

determine the signal quality in burst 

power on/off. It is highly configurable 

to define various types of limit mask.

Figure 6. Power vs. time

Instructions Keystrokes

On the X-Series signal analyzer OFDMA 

mode:

Measure the power versus time  

with burst signal

[Meas] Power vs Time 

Check the burst sync source  

(Figure 6)

[Meas Setup] Burst Sync > RF Amptd
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Demonstration 7:

Modulation analysis

The modulation analysis measurement  

provides a full set of demodulation 

properties that support OFDMA 

scalable parameters including data 

tone modulation, frame length, normal 

bandwidth (BW) ratio, guard interval, 

and FFT size. Relative constellation 

error (RCE) is defined in IEEE 802.16 

for the same result parameter as error 

vector magnitude (EVM). EVM is a 

common modulation quality metric 

widely used in digital communications. 

This measurement takes into account 

all possible error mechanisms in the 

entire transmission chain including: 

baseband filtering, I/Q modulation 

anomalies, filter amplitude and phase 

non-linearities, and power amplitude 

distortions. 

Both downlink and uplink subframe 

modulation analysis can be done with 

the following metrics:

 – IQ measured constellations  

including multiple formats when 

present

 – Subchannelization 

 – Available traces: RCE versus time, 

RCE versus frequency 

 – Data burst information table  

modulation format and size 

Figure 7. Example of an OFDMA frame (with only mandatory zone) in TDD mode

With complex OFDMA frame structure 

as shown in Figure 7, it is necessary 

to have the zone and burst map 

information for correct measurements 

of RCE (EVM) and other demodulation 

results. 

N9075A has three ways to refer the 

zone and burst map information:

1. Setup file (.scp) of Keysight 

N7615B Signal Studio for 802.16 

OFDMA

2. Zone definition file (.omf) of 

Keysight VSA 89601A-B7Y for 

802.16 OFDMA

3. DL-MAP/UL-MAP auto detection 

(preamble index is necessary to 

decode FCH, DL-MAP, and UL-MAP)

Without having correct map informa-

tion, modulation analysis measure-

ment would provide results only for 

FCH (by default).

DL-MAP/UL-MAP auto-detection

When you try to measure a downlink 

signal containing FCH (frame control 

header), DL-MAP, and UL-MAP, 

zone and burst map can be detected 

automatically and decoded into a 

map file to refer to for modulation 

analysis. This DL-MAP/UL-MAP 

auto-detect function is added in MXA 

firmware A.01.10 and EXA firmware 

A.01.20 or later. It is necessary to 

have FCH, DL-MAP, and UL-MAP 

correctly configured in the downlink 

signal to be measured. And you need 

to set up general OFDMA signal 

parameters like radio std and preset 

profiles including BW, FFT size, BW 

ratio, guard Interval, frame duration, 

and downlink radio before using auto-

detect function. 

When you succeed with UL-MAP 

detection and decoding with a 

downlink signal, you can switch radio 

device from BS to MS and use the 

detected map in uplink modulation 

analysis.
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Modulation analysis,  
continued

Here’s an example procedure for 

running a DL-MAP/UL-MAP auto-

detection with a downlink signal.

In this test signal, the default radio 

std and preset profile are used. If you 

would like to measure any downlink 

signals in different profiles or down-

link ratio, for example, please make 

sure that the profiles are correctly set 

before playing the auto-detection.

Figure 8. Data burst summary information

Instructions Keystrokes

On the X-Series signal analyzer  

OFDMA mode:

Go to modulation analysis measurement [Meas] Modulation Analysis

Play DL-MAP/UL-MAP auto-detection 

with the current downlink signal

[Meas Setup] Zone/Data Burst Map >  

Auto Detect Now

View the zone map information with  

measured RCE results for each burst 

(Figure 8)

[View/Display] Zone & Data Burst Info
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Instructions Keystrokes

On the X-Series signal analyzer OFDMA 

mode:

Turn on averaging from Off to On, 20 [Meas Setup] Avg/Hold Num 100 On|Off 

[20] [Enter] Avg/Hold Num 20 On|Off

View the result metrics with averaging 

and peak hold (Figure 9)

[View/Display] Peak/Avg Metrics 

View the spectral flatness view with 

pass/fail limits (Figure 10)

[View/Display] Spectral Flatness

Figure 9. Modulation analysis in statistic metrics

Figure 10. Spectral flatness
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Uplink modulation analysis. Instructions Software operations

On the Signal Studio for WiMAX  

software:

Create a new signal configuration Press [New] on the top tool menu

Set the basic parameters of the signal  

at center frequency 2.5 GHz, amplitude  

–10 dBm

Click Signal Generator and set  

Frequency = 2.5 GHz and  

Amplitude = –10 dBm

Change the output mode from  

downlink only to uplink only (TDD)

Click Waveform Setup to see the  

fundamental waveform signal setups.  

Under Waveform Properties, you can set 

WiMAX common parameters as follows; 

Built frames = 1 

Frame duration = 5 [ms] 

Output mode = uplink only (TDD)

Configure a single carrier signal  

including uplink

Click Uplink, Zone#1 PUSC for signal 

setup.  

Permutation base = 0 

Subchannel rotation = on 

Number of symbols = 6 

Auto allocation = on

Click Burst #1 Modulation and coding = 16QAM (CC) ½ 

MAC PDU#1 with Data Length 420 bytes

Save the signal file for future reuse and  

to import in uplink modulation analysis

File > Save As...> OFDMA_Demo2.scp  

(Name it as you like)

Download the signal to MXG Press Generate and Download on the top 

tool bar
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Figure 11. Symbol power traces in quad view

Instructions Keystrokes

On the X-Series signal analyzer  

OFDMA mode:

Change the device from downlink to 

uplink

[Mode Setup] Radio Device > BS | MS 

Recall the map file for the correct 

demodulation

[Recall] Data > Open  

Choose the file name already created by 

Signal Studio. OFDMA_Demo2.scp is for 

uplink signal analysis.

View the symbol power versus  

subcarrier, symbol power versus symbol 

traces with I/Q symbol constellation

[View/Display] Symbol Power (Quad View)

Change Y scale parameters to see 

power at each subcarrier in upper left 

window

[AMPTD Y Scale] Ref Level [–30] dBm  

Scale/Div [2] dB

Move the selected window to symbol 

power trace at upper right with Select 

Window button under the X-Series 

signal analyze display

Change Y scale parameters to see 

power at each symbol in upper right 

window

[AMPTD Y Scale] Ref Level [–30] dBm  

Scale/Div [2] dB
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Demonstration 8:

Power statistics CCDF

The complementary cumulative  

distortion function (CCDF) is a plot 

which characterizes the signal’s 

higher level power. It provides the 

distribution of peak-to-average power 

ratio (PAR) versus probability and fully 

characterized the power statistics of 

a signal. A CCDF curve is defined by 

how much time the waveform spends 

at or above the given power level. 

Measurement setup parameters:

 – Set a reference trace, compare to 

Gaussian noise trace

 – Select measurement bandwidth 

and measurement interval

 – Choose trigger source: video, line, 

external-½, RF burst, and periodic 

timer

This exercise illustrates the simplicity 

of measuring CCDF. Option B25 is 

required for wider analysis bandwidth 

up to 25 MHz available on X-Series 

signal analyzers.

Figure 12. CCDF

Instructions Keystrokes

On the X-Series signal analyzer OFDMA 

mode:

Measure the CCDF  [Meas] Power Stat CCDF

Select external trigger. (Figure 12) [Trigger] External 1

Web Resources

Product page:  

www.keysight.com/find/n9075a and  

www.keysight.com/find/w9075a

X-Series signal analyzers:  

www.keysight.com/find/X-Series

X-Series advanced measurement applications:  

www.keysight.com/find/X-Series_Apps

Signal Studio software:  

www.keysight.com/find/SignalStudio

Signal generators:  

www.keysight.com/find/sg

http://www.keysight.com/find/n9075a
http://www.keysight.com/find/w9075a
http://www.keysight.com/find/X-Series
http://www.keysight.com/find/X-Series_Apps
http://www.keysight.com/find/SignalStudio
http://www.keysight.com/find/sg
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Netherlands 0800 0233200
Russia 8800 5009286
Spain 0800 000154
Sweden 0200 882255
Switzerland 0800 805353

Opt. 1 (DE)
Opt. 2 (FR)
Opt. 3 (IT)

United Kingdom 0800 0260637

For other unlisted countries:

www.keysight.com/find/contactus

(BP-05-19-14)

www.keysight.com
www.keysight.com/find/mykeysight
www.lxistandard.org
www.keysight.com/find/ThreeYearWarranty
www.keysight.com/find/AssurancePlans
www.keysight.com/quality
www.keysight.com/find/channelpartners
http://www.keysight.com/find/n9075a
www.keysight.com/find/contactus
www.keysight.com/find/contactus

